
Oracle   Enterprise Installed Base

Concepts and Procedures  

Release 11i

October 2001

Part No.  A95145-01



Oracle Enterprise Installed Base Concepts and Procedures, Release 11i

Part No.  A95145-01

Copyright © 2001, Oracle Corporation. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information of 
Oracle Corporation; they are provided under a license agreement containing restrictions on use and 
disclosure and are also protected by copyright, patent, and other intellectual and industrial property 
laws.  Reverse engineering, disassembly, or decompilation of the Programs is prohibited. 

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this 
document is error free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for an purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on 
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice  Programs delivered subject to the DOD FAR Supplement are "commercial 
computer software" and use, duplication, and disclosure of the Programs, including documentation, 
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. 
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer 
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR 
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500 
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the 
Programs. 

Oracle is a registered trademark of Oracle Corporation. Other names may be trademarks of their 
respective owners.



Contents

Send Us Your Comments ..................................................................................................................   vii

Preface ............................................................................................................................................................    ix

Audience for This Guide ......................................................................................................................     ix
How To Use This Guide .......................................................................................................................     ix
Documentation Accessibility ................................................................................................................     x
Other Information Sources ...................................................................................................................     xi
Do Not Use Database Tools to Modify Oracle Applications Data ...............................................     xvi
About Oracle ........................................................................................................................................     xvi

 1 Understanding Oracle Enterprise Installed Base

1.1 Overview of Oracle Enterprise Installed Base ..................................................................    1-1
1.1.1 Installed Base Integration..................................................................................................    1-1
1.2 Inventory Item and Asset Tracking ....................................................................................    1-2
1.2.1 Function Supported by Enterprise Installed Base.............................................................    1-3
1.2.2 Usage Codes......................................................................................................................    1-4
1.3 The Messaging Architecture ...............................................................................................    1-4

2 Understanding Inventory Integration

2.1 Item Instance and Transaction Records .............................................................................    2-1
2.1.1 Transaction Types from Inventory....................................................................................    2-1
2.2 Normal vs Depreciable Inventory Item .............................................................................    2-2
2.3 PO Receipt into Inventory....................................................................................................    2-2
                                                                               iii



2.4 Receiving Items into Asset Subinventories........................................................................    2-2
2.5 Move Orders...........................................................................................................................    2-3
2.5.1 Parts of a Move Order.......................................................................................................    2-4
2.5.2 Move Order Approval Governed by Time-Out and Item Planner....................................    2-4
2.5.3 Creating a Move Order .....................................................................................................    2-4
2.5.4 Transacting a Move Order ................................................................................................    2-6
2.6 Miscellaneous Transaction ...................................................................................................    2-7
2.7 When to Use Miscellaneous Receipts .................................................................................    2-7
2.8 Miscellaneous Receipt...........................................................................................................    2-7
2.9 Miscellaneous Issues .............................................................................................................    2-8
2.10 Miscellaneous Issue to Project .............................................................................................    2-8
2.11 Miscellaneous Receipt from Project ....................................................................................    2-8
2.12 Subinventory Transfers ........................................................................................................    2-9
2.13 Inter-organization Transfers...............................................................................................    2-10
2.13.1 Direct vs In-Transit Transactions....................................................................................    2-10
2.13.2 Inter-organization Transfers Tied to Oracle Inventory...................................................    2-10
2.13.3 Initial Step to Processing Inter-organization Transfers ..................................................    2-10
2.13.4 Inter-Organization Transfer of Items with Serial  Numbers...........................................    2-11
2.13.5 Inter-Organization Transfers of Items without Serial Numbers......................................    2-11
2.13.6 To and From Subinventory Status Must Be Compatible................................................    2-12
2.14 Physical Cycle Counts.........................................................................................................    2-12

3 Understanding Projects Integration

3.1 PO Receipt into Project .........................................................................................................    3-1
3.2 Receiving Items Directly Into an Operating Project .........................................................    3-1
3.3 Transaction Sources from Transaction Import..................................................................    3-3
3.4 Expenditure Inquiry..............................................................................................................    3-4
3.5 Workforce Management .......................................................................................................    3-4
3.5.1 Partial Install and In-Service.............................................................................................    3-4
3.5.2 Steps to Places Project Item Install...................................................................................    3-4
3.5.3 Steps to Places Project Item In-Service.............................................................................    3-5
3.5.4 Project Item Un-Installed..................................................................................................    3-6
3.6 Running a Concurrent Program ..........................................................................................    3-6
3.7 Overview of Projects Requests ............................................................................................    3-7
iv                                                                           



3.8 PRC: Distribute Usage and Miscellaneous Costs .............................................................    3-7
3.9 PRC: Interface Usage and Misc Costs to GL......................................................................    3-8
3.10 PRC: Update Project Summary Amounts..........................................................................    3-8
3.11 Asset Creation........................................................................................................................    3-9
3.11.1 PRC: Generate Asset Lines for a Single Project...............................................................    3-9
3.11.2 PRC: Interface Assets to Oracle Asset............................................................................    3-10
3.12 Invoice Price Variance .........................................................................................................   3-10

4 Understanding the Fixed Asset Architecture

4.1 EIB-FA Concurrent Programs..............................................................................................    4-1
4.2 Depreciable Item Asset Creation.........................................................................................    4-2
4.3 Create Asset for Normal Item..............................................................................................    4-3
4.4 Interface Move Transactions to Fixed Asset .....................................................................    4-4
4.5 Miscellaneous Issue...............................................................................................................    4-6
4.6 Sub-Inventory Transfer.........................................................................................................    4-6
4.7 Inter-Organization Transfer/Item Move............................................................................    4-7
4.8 Physical Inventory and Cycle Count Adjustment ............................................................    4-7
4.9 Case Study For the  eIB-FA Concurrent Programs ...........................................................    4-8
4.10 Understanding the  CLEI ...................................................................................................    4-10
4.11 Overview of Retirements ...................................................................................................    4-10

5 Using Oracle Enterprise Installed Base

5.1 Performing an Inquiry in Installed Base ............................................................................    5-1
5.2 Understanding Installed Base Inquiry ...............................................................................    5-2
5.3 Viewing the Inventory Details ............................................................................................    5-2
5.4 Viewing the Assets ................................................................................................................    5-3
5.5 Submitting a Request ............................................................................................................    5-4
5.5.1 Viewing Request Results..................................................................................................    5-4
5.6 Requesting an eIB Assumed Loss Rate Report .................................................................    5-4
5.7 Requesting an eIB Bill of Lading Report............................................................................    5-6
5.8 Finding Personal Profile Values ..........................................................................................    5-7
                                                                             v



6 Administering Enterprise Installed Base

6.1 Each Transaction Generates a Message..............................................................................    6-1
6.2 Transaction Status Complete(C)..........................................................................................    6-1
6.3 Understanding the Message Dequeuer ..............................................................................    6-2
vi                                                                           



Send Us Your Comments

Oracle Enterprise Installed Base Concepts and Procedures, Release 11 i 

Part No.  A95145-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
document. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us in the following way:

Oracle Corporation 
CRM Content Development Manager
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services.
                                                                                vii



viii                                                     



Preface

Audience for This Guide
Welcome to Release 11i of Oracle Enterprise Installed Base Concepts and 
Procedures.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Enterprise Installed Base

If you have never used Oracle Enterprise Installed Base, Oracle suggests you 
attend one or more of the Oracle Enterprise Installed Base training classes 
available through Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Enterprise Installed Base.

■ Chapter 1 “Understanding Oracle Enterprise Installed Base” provides 
overviews of the application and its components, explanations of key concepts, 
features, and functions, as well as the application’s relationships to other Oracle 
or third-party applications.
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■ Chapter 2 “Understanding Inventory Integration” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the application’s relationships to Oracle Inventory 
application.

■ Chapter 3 “Understanding Projects Integration” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the application’s relationships to Oracle Projects 
application.

■ Chapter 4 “Understanding Fixed Asset Architecture” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the application’s relationships to Oracle Fixed Asset 
application.

■ Chapter 5 “Using Oracle Enterprise Installed Base” provides process-oriented, 
task based procedures for using the Oracle Enterprise Installed Base to perform 
essential business tasks.

■ Chapter 6 “Administering Oracle Enterprise Installed Base” provides 
task-based procedures for required for ongoing system maintenance and 
includes information on administration tools and utilities.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/. 

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace. 
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Other Information Sources
You can choose from many sources of information, including online 
documentation, training, and support services, to increase your knowledge and 
understanding of Oracle Enterprise Installed Base.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle Enterprise Installed Base shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Enterprise Installed Base.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using 
the graphical user interface (GUI) available with this release of Oracle Enterprise 
Installed Base (and any other Oracle Applications products). This guide also 
includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.
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Documents Related to This Product

Oracle Enterprise Installed Base Implementation Guide
This guide provides information required for implementing and setting up 
Installation and System Administration

Oracle Inventory User’s Guide
This guide provides overviews of Oracle Inventory application and its components, 
explanations of key concepts and features.

Oracle Projects User’s Guide
This guide provides overviews of Oracle Projects application and its components, 
explanations of key concepts and features.

Oracle Asset User’s Guide
This guide provides overviews of Oracle Asset application and its components, 
explanations of key concepts and features.

Oracle Purchasing User’s Guide
This guide provides overviews of Oracle Purchasing application and its 
components and features and functions.

Oracle Payables User’s Guide
This guide provides overviews of Oracle Payables application and its components, 
explanations of key concepts and features.

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
xii                                                                                         



automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
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information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Enterprise Installed Base implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.
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Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Enterprise 
Installed Base and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Enterprise Installed 
Base working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your 
hardware and software environment.

Oracl eMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
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download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
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manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Understanding Oracle Enterprise Installed
1

Understanding Oracle Enterprise Installed Base

This topic group provides overviews of Oracle Enterprise Installed Base and its 
components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications. 

1.1 Overview of Oracle Enterprise Installed Base
Oracle Enterprise Installed Base (eIB) is a tracking system that integrates with and 
stores information collected from Inventory, Purchasing, Projects, Assets,  Payables 
and Installed Base. 

With Oracle Enterprise Installed Base, you can give users access to tracking 
information without allowing them access to sensitive processes related to assets 
and purchasing. You can also track inventory items after they have been installed 
and link financial transactions to the physical movement of equipment.

1.1.1 Installed Base Integration
The Oracle Installed Base platform uses the Service Fulfillment Manager to 
integrate Oracle Purchasing, Oracle Payables, Oracle Inventory, Oracle CRL 
Projects, Oracle CRL Assets, and legacy systems to synchronize and manage 
material flow in a company. The Enterprise Installed Base platform minimizes data 
entry by using customer definable business rules to send messages to all other 
related systems to perform the appropriate update when a business event occurs. 
Enterprise Installed Base ultilizes the Oracle Installed Base as its data repository. 
Every transaction that Enterprise Installed Base tracks will be recorded in the IB 
transaction table and each record affected by such transactions will be recored in 
the instance and instance history tables

All setups will be done through IB or other product forms, including Locations, 
Parties etc.
 Base 1-1



Inventory Item and Asset Tracking
1.2 Inventory Item and Asset Tracking
To track inventory items and assets, Oracle Enterprise Installed Base (eIB) must 
interact with several enterprise resource planning (ERP) applications. It sends to 
and receives messages from those applications about the status and location of the 
items you want to track. 

Oracle Enterprise Installed Base (EIB) provides an enterprise tracking and asset 
management system where all inventory, project and asset-related material 
information is stored, providing a 360-degree view of your assets. You can locate 
materials anywhere in the system—in warehouses, on trucks, installed in the 
network, or on project sites, facilitating financial transactions using physical 
movements of material and equipment. In addition, Enterprise Installed Base can 
provide a cradle to grave history of all activity for that equipment..

An asset comprises a collection of items. The items may be trackable or not 
trackable. During implementation, items are designated as Enterprise Installed 
Base-trackable at the master level in Oracle Inventory. Oracle Enterprise Installed 
Base tracks the activity of the trackable items through inventory, projects, and into 
fixed assets. 

In Oracle Assets you perform the Mass Additions concurrent process to create 
assets.
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Inventory Item and Asset Tracking
Figure 1–1 Overview of Message Flows in Oracle Enterprise Installed Base

 

In the Overview of Message Flows in Oracle Enterprise Installed Base diagram, for 
example, when a field service technician enters a report that equipment has been 
placed into service, the workforce management system may send a message to 
Enterprise Installed Base. This message updates the status of the equipment to “In 
Service,” and gives its in-service date to Oracle Projects The asset is now ready to be 
created in Oracle Assets.

1.2.1 Function Supported by Enterprise Installed Base
This application supports the standard functions found in Oracle Inventory, Oracle 
Purchasing, Oracle CRL-Financials Enabled Assets, and Oracle CRL-Financials 
Enabled Projects. 

Oracle Enterprise Installed Base supports the following functions:

■ PO receipt of  items into Inventory
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The Messaging Architecture
■ PO receipt of items into operating projects

■ Move Orders

■ Misc Issue to Project

■ Misc Receipt from Project

■ Installation and un-installation of equipment

■ In-service/Out-of-service of  equipment

■ Subinventory transfers

■ Inter-organization transfers

■ Miscellaneous receipts and issues

■ Placement of assets into or out of service

■ Retirement and Reinstatement of partial or full cost of asset

■ Asset Item move and asset Item transfer

■ Physical Counts

1.2.2  Usage Codes
Installed Base uses a number of location attributes to track the physical location of 
an item instance. Following are Possible statuses:

■ In Inventory 

■ In Process

■ In Transit

■ Installed

■ Uninstalled

■ In Service

■ Out of Service

■ Retired

1.3 The Messaging Architecture
The messaging architecture receives requests from external publishing systems in 
XML (eXtensible Markup Language) format. Based on the input requirements, the 
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The Messaging Architecture
application updates the status and keeps a history of transactions for the tracking 
unit. Subsequently, the application publishes outgoing requests to the subscribing 
systems for further processing. The publishing and subscribing systems include: 
Installed Base, inventory, purchasing,  payables,  assets, projects, workforce 
management, and other legacy system.
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Understanding Inventory Integ
2

Understanding Inventory Integration

This topic group provides the understanding of interaction between Oracle 
Enterprise Installed Base and Inventory, features,  as well as the functionality of the 
transactions in Inventory. 

2.1 Item Instance and Transaction Records
When an item is initially received, typically via a purchase order, a receipt 
transaction occurs. The initial receipt transaction creates a instance record for the 
item.  The receipt transaction record is associated to the item instance record. 
Subsequent transactions against this item will also be associated with the instance 
record and will make up the "history" for that record.

2.1.1 Transaction Types from Inventory
Enterprise Installed Base supports the following transactions types:

■ PO Receipt in Inventory

■ Move Order/Transact Move Order

■ Miscellaneous issue to Project

■ Miscellaneous receipt from Project

■ Miscellaneous receipt/Miscellaneous issue

■ Subinventory transfer

■ Inter-Org transfer

■ Physical Cycle Count
ration 2-1



Normal vs Depreciable Inventory Item
2.2 Normal vs Depreciable Inventory Item
Enterprise Installed Base process Normal and Depreciable item the same with the 
exception of following:

■ Enterprise Installed Base has an ability to create an asset upon receipt of a 
Depreciable item. When the item is received the transaction status is set to 
’COMPLETE’  for Normal Item and ’PENDING’ for Depreciable Item. The 
pending transaction indicates that the financial transaction are required. Please 
refer to FA section for more details.

■ Enterprise Installed Base does not pass the cost of Depreciable item to General 
Ledger. Item cost will be transfered from FA to GL. This is done because asset is 
created when the depreciable item is in Inventory. Normal items however 
works in a standard way.

2.3 PO Receipt into Inventory
PO receipt flow is initiated by the creation of a purchase order. The items are then 
received into inventory against the purchase order when the shipment arrives from 
the vendor.

The Receipt into Inventory package validates  the data against the Install Base 
repository and creates or update the unit record.

■  If Item is serialized, then always a new instance will be created.

■  If Item is non-serialized, then eIB will search for the existing record. The search 
criteria is as follows INVENTORY_ITEM_ID, INV_ORGANIZATION_ID, INV_
SUBINVENTORY_NAME, UOM, INSTANCE_USAGE_CODE, REVISION, 
INV_LOCATOR_ID, LOT_NUMBER (if applicable). If the exact record is found 
then the record will be updated with the new quantity. If not, then the new 
instance will be created.

■ Every receipt builds transaction history.

2.4 Receiving Items into Asset Subinventories
Use the following procedure to receive an item into an asset subinventory. If the 
item is not received in asset subinventory then expenditures items will not be 
created in Oracle Projects
2-2 Oracle Enterprise Installed Base Concepts and Procedures



Move Orders
Prerequisites

At least one subinventory must exist. The item number must be defined in Oracle 
Inventory. The purchase order must exist in Oracle Purchasing with a status of 
Approved.

Steps

1. In the Inventory responsibility, navigate to Transactions >Receiving > 
Receipts.

The Organizations window opens.

2. Choose your organization from the Organizations window and click Find.

3. In the Find Expected Receipts window, enter criteria that identifies the items 
you are receiving, such as the purchase order number.

4. In the Receipt header, enter the packing slip number and any other pertinent 
information.

5. In the Receipt lines, verify the quantity to be received. 

You may receive a partial line quantity.

6. Verify that the destination subinventory entered on the purchase order is not 
depreciable.

7. Click Lot-Serial. 

If the item is under lot control, enter the equipment code (CLEI) in the Lot field. 

If the items are under serial control, enter individual serial numbers or a range 
of consecutive numbers. You may also enter corresponding vendor serial 
numbers in the Manufacturing Serial Number field.

8. Choose File > Save to complete the receipt.

2.5 Move Orders
A move order transfers inventory:

■ From one stocking location to another

■ From a stocking location to a project

To create a move order, you manually create a move order requisition. After the 
move order requisition is approved, it becomes a move order. If the organization 
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does not require approval, the manual request automatically becomes a move 
order. 

Enterprise Installed Base uses the following types of move orders:

■ Enterprise Installed Base Move Order Issue to Project, to create a document 
for moving material from inventory to a project 

■ Enterprise Installed Base Move Order Subinventory Transfer, to create a 
document for moving material from one subinventory to another subinventory. 
See Understanding Subinventory Transfers.

2.5.1 Parts of  a Move Order 
A Move order comprises three parts:

■ The Move Order Header holds the move order number, an optional description 
of the move order, and information to default to the individual move order 
lines.

■ The Move Order Lines are the actual move requests, including: the item 
number, requested quantity, completed quantity, the source and destination 
information.

■ The Line Details are the inventory transactions that occur to fullfill a move 
order line, including: equipment code, serial number, quantity moved, source 
and destination details (such as locators).

2.5.2 Move Order Approval Governed by Time-Out and item Planner
At the organization level, three attributes-Move Order Time-out Period, Time-out 
Action, and Item Planner item-affect how move order requisitions are approved. If 
the move order requisition is not approved before the time-out period passes, 
Oracle Workflow sends a reminder notice to the item planner. If the move order 
requisition is still not approved within a second time-out interval, the requisition is 
automatically approved or rejected based on the Time-out Action setting. If no item 
planner is specified for the item, the requisition line is approved automatically.

2.5.3 Creating a Move Order 
Create a move order when you need to transfer inventory across subinventories or 
into a project account. Use the following steps to create a move order.
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Prerequisites

Inventory setups, such as item and subinventory definition, must be complete. At 
least two transactions EIB Subinventory Transfer and EIB Issue to Project must also 
be defined. If you use an Oracle Workflow process to route move order requisitions 
for approval, the item must be assigned to an item planner.

Steps

1. In the Inventory responsibility, navigate to Move Orders > Move Order.

2. In the Move Order window, enter an order number in the Number field. 

If you do not insert a value, the application fills the Number field. You may also 
enter a description of the order in the Description field.

3. In the Default region, you enter the following information:

Transaction type. Select either eIB Sub-inventory Transfer or  eIB Issue to 
Project.

Required Date. Enter the requested delivery date

Also enter Ship-to Location, Source and Destination subinventories. 

4. Enter the following information on the lines on each of the tabs:

■ Item: the item number, item revision (if under revision control), quantity to 
move

■ Project and Task

■ Source: source subinventory (if different from the default value), locator (if 
locator control is enabled), equipment code (CLEI), and serial numbers. If 
you do not know what subinventory the item should be transferred from, 
click On Hand at the bottom of the window to search for material locations.

■ Destination: the destination subinventory or account, if different from the 
default value and the destination locator for a subinventory transfer type 
move order

■ Control: the move order transaction type, if different from the default 
value, a predefined reason code or alphanumeric reference information. 

If approval is required, the item planner receives a Workflow notification that there 
are move order requisition order lines awaiting approval. The planner uses Oracle 
Workflow to approve the orders.
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The item planner chooses Approve or Reject for each move order requisition line. If 
one requisition line on a move order is rejected, other lines of the same move order 
can be approved. Action defined on a move order line cannot be performed without 
approval.

2.5.4 Transacting a Move Order
After a move order is approved, you transact the move order by performing the 
action described on the approved lines. Use this procedure to perform the approved 
transaction.   

Prerequisites

The move order must be approved.

Steps

1. In the Inventory responsibility, navigate to Move Orders > Move Orders 

2. Locate move orders that have been approved. 

You can query by header, line, source, or destination information. 

3. To add details to the move order line, check the Select box for each line you 
wish to detail and click Location . 

Information is automatically entered on the transaction lines of the move order, 
based on the inventory picking rules and transaction defaults defined within 
the organization.

4. Click View/Update to view the detailed lines. 

You can manually update any information that is incorrect. Add missing 
information, such as equipment code (CLEI) and serial numbers.

5. If you do not require a pick slip, click Transact to execute the detailed lines. 

If you need to print a pick slip, save the transaction at this point. When the pick 
slip is ready, return to the Transact Move Orders window, select the line(s) to 
be executed, and click Transact. 
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2.6 Miscellaneous Transactions
Oracle Enterprise Installed Base (EIB) supports the miscellaneous 
transactions–receipts and issues–used by Oracle Inventory. Each transaction in 
Inventory triggers a message to Enterprise Installed Base. 

Enterprise Installed Base does not adjust asset units in Fixed Assets to a number less 
than one. Enterprise Installed Base does not adjust asset units to a number less than 
zero. If the transaction would cause a negative balance, Enterprise Installed Base 
adjusts the assets only to zero.

See also:

■ When to Use Miscellaneous Receipts

■ Miscellaneous Issues

2.7 When to Use Miscellaneous Receipts
Use miscellaneous receipts to receive material without a purchase order number. 
Oracle Enterprise Installed Base uses the same process for performing a 
miscellaneous receipt as the process used in standard Oracle Inventory. You may 
also need to enter a lot, or a serial number

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous 
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining 
Distributions.

2.8 Miscellaneous Receipt
Use miscellanous receipts to receive material without a purchase order number. 
Oracle Enterprise Installed Base uses the same process for performing a 
miscellaneous receipt as the process used in standard Oracle Inventory. In addition, 
You may also need to enter an equipment code (CLEI) in the Lot field, or a serial 
number.

■ If the Item is serialized, the always a new instance will be created.

■  If Item is non-serialized, then eIB will search for the existing record. The search 
criteria is as follows INVENTORY_ITEM_ID, INV_ORGANIZATION_ID, INV_
SUBINVENTORY_NAME, UOM, INSTANCE_USAGE_CODE, REVISION, 
INV_LOCATOR_ID, LOT_NUMBER (if applicable). If the exact record is found 
then the record will be updated with the new quantity. If not, then the new 
instance will be created.
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2.9 Miscellaneous Issues
In Oracle Enterprise Installed Base, the process for performing a miscellaneous 
issue is the same as the process used in standard Oracle Inventory. In addition, you 
can enter a lot in the Lot field and a serial number for serial and lot controlled items.

■ If the item is serialized, then the instance record will be updated to zero 
quantity.

■  If Item is non-serialized, then eIB will search for the existing record. The search 
criteria is as follows INVENTORY_ITEM_ID, INV_ORGANIZATION_ID, INV_
SUBINVENTORY_NAME, UOM, INSTANCE_USAGE_CODE, REVISION, 
INV_LOCATOR_ID, LOT_NUMBER (if applicable). The record will be updated 
to the appropriate quantity.

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous 
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining 
Distributions.

2.10 Miscellaneous Issue to Project
Issue to Project is a user defined transaction type in Oracle Inventory which comes 
seeded with Oracle Installed Base. It works exactly the same way as standard Move 
Order.

■ For serialized item the instance record is updated. Instance usage code changes 
to ’IN PROCESS’.

■ For non-serialized item a new instance will be created with instance code = ’IN 
PROCESS’. If the record exists for the same instance then that record will be 
updated. The search criteria is as follows INVENTORY_ITEM_ID, INV_
ORGANIZATION_ID, INV_SUBINVENTORY_NAME, UOM, INSTANCE_
USAGE_CODE, REVISION, INV_LOCATOR_ID, LOT_NUMBER (if 
applicable).

2.11 Miscellaneous Recceipt from Project
Miscellaneous receipt from project is used to transfer material from Projects back to 
Inventory. Receipt from Project is a user defined transaction type in Oracle 
Inventory which comes seeded with Oracle Installed Base.

■ For serialized item the instance record is updated. Instance usage code changes 
to ’IN INVENTORY’.
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■ For non-serialized item a new instance will be created with instance code = ’IN_
INVENTORY’. If the record exists for the same instance then that record will be 
updated with appropriate quantity. The search criteria is as follows 
INVENTORY_ITEM_ID, INV_ORGANIZATION_ID, INV_SUBINVENTORY_
NAME, UOM, INSTANCE_USAGE_CODE, REVISION, INV_LOCATOR_ID, 
LOT_NUMBER (if applicable).

■ Project expenditures will be reversed by running Cost Collector program. This 
will reduce the Project cost with the transacted item cost.

2.12 Subinventory Transfers
A subinventory transfer moves material inventory between subinventories. A 
subinventory is a unique physical or logical separation of material inventory, such 
as raw inventory, finished goods or defective material. All material within an 
organization is held in one or more subinventories. 

A move order initiates a subinventory transfer. Oracle Enterprise Installed Base 
handles these transfers in the same manner that Oracle Inventory handles them.

The way Enterprise Installed Base processes a subinventory transfer is based 
initially on whether or not the transferred item has a serial number.

(1)     Item with a Serial Number: 

Enterprise Installed Base searches the database for the From record associated to the 
item. This record must have a status of ’IN INVENTORY’’ and a transaction status 
of ’COMPLETE’. Once Enterprise Installed Base locates the record, it updates the 
item’s subinventory in the From record.

(2)     Item without a Serial Number:

Enterprise Installed Base searches the database fro the From and To records. These 
records must have a status of either ’IN INVENTORY’ and a transaction status of 
’COMPLETE’. Once Enterprise Installed Base locates the records, it updates the 
item’s subinventory in both the From and To records.

■ The source instance (sub-inventory instance record from which item is 
transferred) and the destination instance (sub-inventory instance record to 
which item is transferred) is searched on the following criteria: INVENTORY_
ITEM_ID, INV_ORGANIZATION_ID, INV_SUBINVENTORY_NAME, UOM, 
INSTANCE_USAGE_CODE, REVISION, INV_LOCATOR_ID, LOT_NUMBER 
(if applicable).
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■ If both source and the destination records are found then they will be updated 
with transaction quantity. If either of the instance record is not found then it 
will be created. 

For more information on how subinventory transfer are processed, see Oracle 
Inventory User’s Guide:

2.13 Inter-organization Transfers
An inter-organization transfer moves items between organizations. This transfer 
may be either a Direct or an In Transit transaction.

2.13.1 Direct vs In-Transit Transactions
In a Direct Transaction, the shipping organization transfer the item into a 
subinventory in the receiving organization. For this reason, the application treats a 
Direct inter-organization transfer the same as a subinventory transfer.

For an In-Transit transaction, the moneytary value of the transferred item is 
deposited in an in-transit account and the inventory account of the shipping 
organization receives credit for the item. Upon receipt of the transferred item, the 
receiving organization must perform a receipt transaction to bring the item into its 
inventory. The receipt transaction credits the in-transit account and debits the 
inventory account of the receiving organization.

2.13.2 Inter-organization Transfers Tied to Oracle Inventory
Oracle Enterprise Installed Base uses the same process that Oracle Inventory uses to 
transfer materials between organizations. Before items can be transferred, items 
must be defined and subinventories must be created in Oracle Inventory.

If the organization from which the item is being transferred does not allow negative 
inventory balances, it must contain sufficient on-hand inventory for the transaction 
to occur.

2.13.3 Initial Step to Processing Inter-organization Transfers
If the inter-organization transfer is a Direct transaction, the application treats it the 
same as a Subinventory transfer. 

If the inter-organization transfer is an In Transit transaction, the application 
searches the database for the From record associated to the item. This record must 
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have a status of In Inventory or In Depreciable Inventory and a transaction status of 
Complete. If the item fails to meet these conditions, it generates an error message.

There is no difference, from an Enterprise Installed Base perspective, between a 
FOB Shipment or FOB Receipt type transaction.

2.13.4 Inter-Organization Transfers of Items with Serial Numbers
The in-transit transfer of an item with a serial number from one organization to 
another, the application follows these steps:

(1)     In-Transit Shipment: 

The source record for the From organization and subinventory will be located. Then 
it will be updated with status ’IN-TRANSIT’ and the To organization. The 
subinventory information will be removed from the recod. If the transaction is 
successfully processed, transaction records will be created to store the transaction 
history

(2)     In-Transit Receipt:

When the item reaches its destination, someone enters a receipt transaction for the 
item. The ’IN-TRANSIT’ record with the To organization will be located. It will be 
updated with status ’IN INVENTORY’.

2.13.5 Inter-Organization Transfers of Items without Serial Numbers
The in-transit transfer of an item without a serial number from one organization to 
another, the application follows these steps:

(1)     In-Transit Shipment: 

The source record for the From organization and subinventory will be located and 
the quantity will be substracted by the transaction quantity. An ’IN-TRANSIT’ 
record will then be created with the destination organization and transaction 
quantity. No subinventory information will be kept in this record. If such a record 
already exists, the quantity will be increased by the transaction quantity.

(2)     In-Transit Receipt:

When the item reaches its destination, someone enters a receipt transaction for the 
item. The ’IN-TRANSIT’ record with the To organization will be located. The 
quantity will be substracted with the transaction quantity. The destination record 
will be located based on the To organization and subinventory. If the record exists , 
the quantity will be increased by the transaction quantity. If there is no such record, 
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a new destination record will be created. If the transaction is successfully processed, 
transaction records will be created to store the transaction history.

2.13.6 To and From Subinventory Status Must Be Compatible
A subinventory may have a status of either Depreciable or Normal. An item can 
only be transferred between subinventories that have the same status. Item cannot 
be transferred from Depreciable to Normal subinventories, or vice versa. If the 
status of the From subinventory does not match the status of the To subinventory, 
the application generates an error.

2.14 Physical Cycle Counts
A physical inventory occurs when a person verifies that units exist physically and 
that the quantities match the on-hand records in Enterprise Installed Base. Based on 
the results of the physical inventory, Enterprise Installed Base supports adjustments 
that you make to your inventory balances. Depending on the type of inventory 
adjustment necessary, Enterprise Installed Base treats these adjustments like a 
miscellaneous transaction. For example, if the item quantity increases after physical 
count then there will be Miscellaneous receipt transaction.

See also:

■ When to Use Miscellaneous Receipts

■ Miscellaneous Issues
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Understanding Projects Integration

This topic group provides the understanding of interaction between Oracle 
Enterprise Installed Base and Projects, features,  as well as the functionality of 
Oracle Projects. 

3.1 PO Receipt into Project
PO receipt flow is initiated by the creation of a purchase order. The items are then 
received into Project against the purchase order. The Enterprise Installed Base PO 
Receipt package validates the receipt data against the Installed Base respository and 
creates or update the instance depends upon the physical attibutes of the instance.

■ For non-serialized item physical attributes are combinations of INVENTORY_
ITEM_ID, PROJECT_ID, TASK_ID and INSTANCE_STATUS_ID. If either of 
these attributes are different then create a new instance in Install Base. If these  
attributes are match then add new receipt to the same instance.

■ For serialized item, Installed Base always create  a new instance.

■ During process of creating PO for expense items i.e. receipt into project, ’accrue 
on receipt’ flag on PO shipments must be unchecked and use destination type 
as EXPENSE.

■ Run PRC: Transaction Import process to create the project expenditures  after 
the receipt is complete. Use Expenditure Inquiry form in Oracle Project to view 
the expenditures. 

■ For depreciable item, asset is created upon receipt, so the cost gets  transferred 
from Fixed Asset to General Ledger and not from Oracle Project

3.2 Receiving Items Directly into an Operating Project
Use the following procedure to receive an item into an operating project.
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Prerequisites

The purchase order must exist in Oracle Purchasing with a status of Approved. The 
purchase order line must include: 

■ The project and task numbers for the item

■ The accrue upon receipt flag must be unchecked

■ The Expense destination type

The item number must be defined in Oracle Inventory. The project must be defined, 
with a status of Active.

Steps 

1. In the Inventory responsibility, navigate to Transactions >Receiving > 
Receipts.

The Organizations window opens.

2. Choose your organization from the Organizations window and click Find.

3. In the Find Expected Receipts window, enter any criteria that identifies the 
items you are receiving, such as the purchase order number and the item 
number, and click Find.

The Receipt Header and Receipt Lines open to display items that match the 
criteria entered.

4. In Receipt Header, enter the packing slip number and any other pertinent 
information.

5. Verify that the Receipt line has a value for Deliver-to location. 

When project information has been entered on the purchase order, the 
Deliver-to location is defined and appears on this Receipt line. 

Note: A Depreciable item can also be received directly into a 
project.
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6. Click Save to receive the item into the project and commit the receipt 
transaction.

The application looks for an existing record for the item. If it locates a record 
and the receipt transaction has processed successfully, it updates the item 
record with the quantity received. 

If the application does not find an existing record, it creates one for the receipt. 
The application sets the unit’s status to In Inventory and its transaction status to 
Complete. 

3.3 Transaction Sources for Project Import
Transaction sources identify the source of external transactions you import into 
Oracle Projects using Transaction Import. For example, you can define the 
transaction source Payroll to identify expenditure items imported from an external 
payroll system. Transaction Import imports the transactions and creates 
corresponding expenditure records in the Oracle Projects expenditure tables.  
Following are Enterprise Installed Base transaction sources:

■ CSE_INV_ISSUE: Use this transaction for importing expenditures of "Issue to 
Project" for Normal item

■ CSE_INV_ISSUE_DEPR: Use this transaction for importing expenditures of 
"Issue to Project" for Depreciable item

■ CSE_IPV_ADJUSTMENT: Use this transaction for cost to be adjusted to the 
Project

■ CSE_IPV_ADJUSTMENT_DEPR: Use this transaction for cost to be adjusted to 
the Asset

■ CSE_PO_RECEIPT: Use this transaction for Receipt into Project for Normal item

■ CSE_PO_RECEIPT_DEPR: Use this transaction for Receipt into Project for 
Depreciable item

■ INVENTORY MISC: Use this transaction for Miscellaneous transactions such as 
Miscellaneous Issue and Miscellaneous Receipt

Note: The Deliver-to location must be setup in the Enterprise 
Installed Base Locations form and have an associated FA location.
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3.4 Expenditure Inquiry
After the expenditure records are created through Transaction Import, use 
Expenditure Inquiry window to review a project’s expenditure items. You can see 
the amount and type of expenditure items charged to a project, how much revenue 
has accrued for an expenditure item, and other information about the project’s 
expenditure items. For normal items which came through inventory, the 
expenditures will not be created until concurrent process: PRC Distribute Usage 
and Miscellaneous Costs is run.

For more information, see Oracle Projects User’s Guide: Transaction Import.

3.5 Workforce Management
The purpose of the integration with Workforce Management (WFM) is to signal the 
completion of operational tasks, update the status in the Installed Base, and initiate 
the asset creation/update processes in Projects and Fixed Assets.

Workforce Management transactions are initiated by the external Workforce 
Management module. Workforce Management module is an external field service 
system which used by the field operations to install and maitain equipment. 
Enterprise Installed Base provides an interface API for external Workforce 
Management module to transmit transaction parameters to Enterprise Installed 
Base.

3.5.1 Partial Install and In-Service
When material is issued from inventory to a project a cost expenditure is created in 
Project Accounting which includes the quantity and the cost of material. Oracle 
Enterprise Installed Base then sends message (Install and In-Service) to Project 
Accounting to trigger the capitalization of this expenditure  in partial or full of the 
material on the project. E.g. 10 items have been issued to the project. The technician 
installs 5 and then places In-Service only 3 items. This would mean that only 3 (or a 
cost expenditure equal to 3x the per unit cost) would be capitalized immediately.

3.5.2 Steps to places Project Item Install
The following are steps to places Project Item Installed in Workforce Management 
form.

Prerequisites
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None.

Steps

1. In the Oracle Enterprise Install Base responsibility, navigate to Workforce 
Management form.

2. Enter valid data for fields: Organization, Item Number, Work Order Number, 
Transaction Date, Transaction By, Transaction Type, Project Number,  Network 
Location and Quantity.

3. Click Apply when you have finished enter data. 

The item record is updated with status ’Install’ in Install Base.

3.5.3 Steps to Places Project Item In-Service
The following are steps to places Project Item In-Service in Workforce Management 
form.

Prerequisites

None.

Steps

1. In the Oracle Enterprise Install Base responsibility, navigate to Workforce 
Management form.

2. Enter valid data for fields: Organization, Item Number, Work Order Number, 
Transaction Date, Transaction By, Transaction Type,  Network Location and 
Quantity.

3. Click Apply when you have finished enter data. 

The item record is updated with status ’In Service’ in Install Base.
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3.5.4 Project Item Un-Installed
Projects under construction can be scrapped totally or they might have extra 
materials. In any case, installed items will be sent back to inventory. Oracle 
Enterprise Base supports these transactions. Items Installed can be Un-installed 
(partially or fully quantity) and sent back to  inventory through miscellaneous 
transaction. Enterprise Installed Base handles these for normal as well as 
depreciable items. Unit adjustments are done immediately. For reversing the 
expenditure items and balancing the project cost you have to run the cost collector 
program. The cost collector program creates the negative expenditures for 
un-installed items.

3.6 Running a Concurrent Program
Enterprise Installed Base provides two concurrent programs for transferring invoice 
cost adjustments to Assets or Projects:

■ PRC: Interface Payables Invoice Cost Adjustments to Assets

■ PRC: Interface Payables Invoice Cost Adjustments to Projects

Use this procedure to run a concurrent program. 

Steps

1. In the Enterprise Installed Base responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose one of the concurrent processes.

4. In the Parameters window, enter information to define the items you want to 
include in the process. 

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also:

■  Viewing Request Results
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3.7 Overview of Projects Requests
You can run the following requests, and concurrent processes in Projects.

■ PRC: Transaction Import

■ PRC: Distribute Usage and Miscellaneous Costs.

■ PRC: Interface Usage and Miscellaneous Costs to General Ledger. 

■ PRC: Update Project Summary Amounts.

■ PRC: Generate Asset Lines for a Single Project

■ PRC: Interface Assets to Oracle Asset

3.8 PRC: Distribute Usage and Miscellaneous Costs
You need to run this process for the Normal items which received into inventory 
first then Issued to Project. Transaction "CSE Issue to Project" is not GL "accounted" 
so you have to run this process to created expenditures. Item instance quantity will 
updated immediately.

Prerequisites

None.

Steps

1. In the CRL 11i Projects responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose PRC: Distribute Usage and Miscellaneous Costs.

4. Click Submit

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results
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3.9 PRC: Interface Usage and Misc Costs to GL
Use this concurrent program to collects all eligible usage costs in Oracle Projects 
and interfaces them to the Oracle General Ledger interface tables. The interface 
process also determines the liability account for the usage costs.

Prerequisites

None.

Steps

1. In the CRL 11i Projects responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose PRC: Interface Usage and Miscellaneous Costs to 
General Ledger.

4. Click Submit

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results

3.10 PRC: Update Project Summary Amounts
Use this concurrent program to updates the project summary amounts with new 
cost, commitment, and revenue transaction and any new baselined budget versions.

Prerequisites

None.

Steps

1. In the CRL 11i Projects responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.
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3. In the Name field, choose PRC: Update Project Summary Amounts.

4. Click Submit

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results

3.11 Asset Creation
Once the expenditures are created in projects, user can create an asset. The 
following three steps required for creation of Asset:

1. Run Generate Asset Lines for a Single Project

2. Run Interface Assets to Oracle Asset

3. Run Post Mass Additions

3.11.1 PRC: Generate Asset Lines for a Single Project
Use this concurrent program to generates summary asset lines for a single project.

 Prerequisites

None.

Steps

1. In the CRL 11i Projects responsibility, navigate to Requests > Run.

2. Choose to run either a single report.

3. In the Name field, choose PRC: Generate Asset Lines for Single Project

4. Click Submit

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results
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3.11.2 PRC: Interface Assets to Oracle Asset
Use this concurrent program to sends valid asset lines to Oracle Assets to become 
fixed assets. The process creates one mass addition line in Oracle Asset for each 
asset line in Oracle Projects, assigning the asset information you entered for the CIP 
asset to the mass addition line in Oracle Assets.

Prerequisites

None.

Steps

1. In the CRL 11i Projects responsibility, navigate to Requests > Run.

2. Choose to run either a single report.

3. In the Name field, choose PRC: Interface Assets to Oracle Asset.

4. Click Submit

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results

3.12 Invoice Price Variance
Enterprise Installed Base creates item expenditures at PO cost. Once the invoice is 
created, the cost difference if there is any has to be adjusted in PA or FA. For the 
depreciable items, the difference will be adjusted in FA. For non-depreciable items, 
the adjustment will be done in PA. The invoice should be approved and accounts 
must be created. Also you need to interface AP transaction to GL before adjusting 
IPV for depreciable items. ’ need to run a concurrent program to ensure that the 
construction cost of the project is as close to the actual cost as possible.  Two types of 
Invoice Price Variance (IPV) are available:

(1)     Invoice Price Variance in Project: In Order to adjust the cost from Payables,  it 
needs to bring in invoice cost from Payables into Project and then assign attributes 
to new expenditures. Following are steps:

■ Run Interface Payables Invoice Cost Adjustments to Projects. 
3-10 Oracle Enterprise Installed Base Concepts and Procedures



Invoice Price Variance
■ Assign attributes to new expenditure in Expenditure Inquiry form based on  
Asset category, Location and Product. 

(2)     Invoice Price Variance in Asset:  In order to adjust the cost from Payables, 
user needs to bring in invoice cost from Payables into Asset and then update the 
Mass Addition table. Following are steps:

■ Run Interface Payables Invoice Cost Adjustments to Asset. 

■ Run Post Mass Additions for the category book. 
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Understanding Fixed Asset Architecture

When Enterprise Installed Base needs to create a Fixed Asset (FA) transactions, the 
transaction is stored in a transaction log. Later, a concurrent program  read the 
transaction log and process the transactions in sequence. Each transaction in the log 
is process by the Enterprise Installed Base business logic and/or a client extension. 
The Enterprise Installed Base business logic or the client extension determine the 
appropriate FA transaction, retreive the required FA data, insert a record in to the 
appropriate FA interface and submit the FA program. A tieback, from FA return the 
asset ID to the Enterprise Installed Base business logic/client extension and update 
the Install Base Instance-Asset assignment table.

4.1 EIB-FA Concurrent Programs
The eIB-FA programs drastically reduces or completely eliminates the amount of 
manual intervention required to maintain your financial system.

eIB has an ability to create and update Oracle Assets by using concurrent programs. 
One the asset is created, any physical movements of the item will automatically 
update the financial records. For example, when a depreciable item is received, run 
appropriate concurrent program to create an asset. Now the asset is linked with the 
item. Lets suppose item is moved to a different organization. eIB will check for asset 
location change and make necessary changes in asset distributions after running 
Asset-Item Move concurrent program.

eIB also maintains the history of all the transactions performed. This gives user total 
visibility of all items and their related assets.
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Depreciable Item Asset creation
All above transactions will be marked for eIB-FA concurrent program processing. 
The concurrent program picks these transaction and process sequentially.

4.2 Depreciable Item Asset creation
This concurrent program will process the following transaction to create an asset for 
depreciable item.

Process Steps:

You need to run the following programs after receipt of depreciable item to create 
an asset.

(1) Run ’Depreciable Items - Asset Creation’ from Oracle Install Base

(2) Run ’Post Mass Additions’ from Oracle Assets

Table 4–1

Name of the program Description

Depreciable Items - 
Asset creation 

This is a group of concurrent programs which creates an 
asset or cost adjustment when depreciable item is 
received either in In-inventory or in Projects

Create Assets for 
Normal Items

This is a group of concurrent programs which creates an 
asset or cost adjustment when normal item is put in 
service. Create Assets for normal assets is a concurrent 
request set

Interface Move 
Transaction to fixed 
Asset

This is a concurrent program which processes any item 
moves like Sub-inventory Transfer, Inter-organization 
transfer, Miscellaneous Issues and Physical Inventory 
adjustments for which asset already exists.

Table 4–2

Install Base Transaction Source Description

Install Base 
Transaction 
Status Meaning

PO_RECEIPT_INTO_
INVENTORY

Receipt of 
depreciable item into 
Inventory

PENDING Need further 
FA/PA 
processing

PO_RECEIPT_INTO_PROJECT Receipt of 
depreciable item into 
projects

PENDING Need further 
FA/PA 
processing
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Create Asset for Normal Items
Note:

■ For project related receipts the billable flag is already set to ’NO’ to prevent the 
account information going to GL and avoid double accounting.

■ Ship to location is the mandatory field on PO, so the corresponding FA location 
will be used to create an asset. Asset category will be extracted from the item 
definition

■ The CSE profile must be set for FA Book type.

■ Vintage pooling will be available for all non-serialized depreciable items. Any 
receipt will be added to the existing asset if the receipt year is the same. Receipt 
date should be defaulted to the first day of the current fiscal year. However 
users can customize it through client extension.

■ In the case of serialized item instance, a new asset will be always created. For 
non-serialized item instances, a new asset will be created if the asset category is 
different or in case of vintage pooling, if the receipt year is different.

■ If the asset already exists for that category then the program will perform cost 
and unit adjustments.

After the post mass additions program is complete, the asset number will be link to 
the item instance.

4.3 Create Asset for Normal Items
This concurrent program will process the following transactions to create an asset 
for normal items put ’In-service’.

Process Steps:

You need to run the following programs after normal tem is put ’In-service’ to 
create asset.

Table 4–3

Installed Base 
Transaction Source Description

Install Base Transaction 
Status Meaning

PROJECT_ITEM_IN_
SERVICE

Item put 
In-service

INTERFACE_TO_PA Need further 
FA/PA 
processing
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Interface Move Transactions to Fixed Asset
(1) Run concurrent request set ’Create Assets for Normal Items’ from Oracle Install 
Base

(2) Run ’Generate Asset Lines for a Single Project’ from Oracle Projects

(3) Run ’Interface Asset to Oracle Assets’ from Oracle Projects

(4) Run ’Post Mass Additions’ from Oracle Assets

Note:

■ Item has to be issued to the Project or received in the project before installing 
and putting it in service. Also make sure to create expenditures before 
installing. This is a prerequisite for asset creation. Expenditures will be created 
by running the Project Transaction Import program. The details are covered in 
Projects Integration section.

■ If you run this program without creating expenditures then this program 
creates project expenditures but not the asset.

■ In the case of serialized item instances, a new asset will be always created. For 
non-serialized item instances, a new asset will be created if asset category is 
different.

■ If the asset already exists for that category the program will perform cost and 
unit adjustment.

■ FA location corresponding to network location will be used to create an asset. 
Asset category will be extracted from the item definition

■ FA Book type will be used from CSE profile.

After successful completion of Post Mass Additions, the asset will be created or 
updated for the new ’In-service’ item instance.

4.4 Interface Move Transactions to Fixed Asset
This concurrent program processes the following transactions if the asset exists for 
the item instance which is transacted:
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Interface Move Transactions to Fixed Asset
PROJECT

The prerequisite to run this program is that the above two concurrent programs for 
asset creation should be completed. All the transaction will be processed 

Table 4–4

Install Base Transaction Source Description

Install Base 
Transaction 
Status Meaning

MISC_ISSUE Miscellaneous 
issue of item out 
of inventory

PENDING Need further 
FA/PA processing

PROJECT_ITEM_UNSTALLED Item is 
Un-installed 
from the project

PENDING Need further 
FA/PA processing

MISC_RECEIPT_FROM_PROJECT Item is moved 
from Projects into 
Inventory

PENDING Need further 
FA/PA processing

SUBINVENTORY_TRANSFER Transfer of an 
item within the 
organization 
from one 
sub-inventory to 
another

PENDING Need further 
FA/PA processing

INTERORG_TRANSFER Transfer of an 
item from one 
organization to 
the other

PENDING Need further 
FA/PA processing

MOVE_ORDER_ISSUE_TO_
PROJECT

Item issued to the 
project

PENDING Need further 
FA/PA processing

PROJECT_ITEM_INSTALLED Equipment 
Installed

PENDING Need further 
FA/PA processing

PROJECT_ITEM_IN_SERVICE Equipment 
In-service

PENDING Need further 
FA/PA processing

IN_SERVICE Asset is put in 
service

PENDING Need further 
FA/PA processing

PHYSICAL_INVENTORY, 
CYCLE_COUNT

Asset adjustment 
when the item is 
adjusted in 
inventory in 
physical count

PENDING Need further 
FA/PA processing
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Miscellaneous Issue
sequentially. If there is any dependent transaction pending then this transaction 
will be skipped.

Processing Steps:

You need to run the following programs:

(1) Run concurrent program ’Interface Move Transactions to Fixed Asset’ from 
Oracle Install Base

(2) Run ’Post Mass Additions’ from Oracle Assets

Note:

■ In the case of depreciable item the above movements will be tracked since asset 
is created upon receipt. For Normal item, only asset item move transactions will 
be tracked.

■ The program will check for any asset updates due to change in location. For 
example, when item is issued to the project the location is changed from 
inventory to project location. If these locations belong to different FA locations 
then this change will cause different distribution in the asset. Interface Move 
transactions to Fixed Asset will process this change. The transactions will be 
processed sequentially because of dependcies.

4.5  Miscellaneous Issue
When the item is issued out of inventory, eIB-FA concurrent program will change 
the status of the transacted quantity to retired.

4.6 Sub-Inventory Transfer
When the item is transferred from one sub-inventory to other, the program will 
perform FA location change which in turn will change the FA distributions. Asset 
however will remain the same.

In a situation where there exists more than one source record,  First In First Out 
method will be adapted. If more than one destination asset record exists then asset 
year will be matched to adjust the asset. When searching for the existing asset in the 
system, program will always look to see if there exists similar record under process. 
If it finds the exact match then the record will be skipped.
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Physical Inventory and Cycle Count Adjustments
In the business rule dictates change in location as change in category then you have 
to modify client extension. In that case a new set asset will be created for serialized 
item. The original asset cost will be updated to zero and you have to retire the asset 
manually. Similar unit and cost adjustments will be done in source and destination 
assets in the case of non-serialized items.

4.7 Inter-Organizational Transfer/Item Move
When the item is transferred from one organization to the other, the program will 
perform FA location change which in turn will change the FA distributions. Asset 
however will remain the same. The transaction include ’PROJECT_ITEM_
INSTALLED’, ’PROJECT_ITEM_UNINSTALLED’, ’IN_SERVICE’, ’MISC_
RECEIPT_FROM_PROJECT’, ’MISC_ISSUE_TO_PROJECT’, MOVE_ORDER_
ISSUE_TO_PROJECT’, ’PROJECT_ITEM_IN_SERVICE’.

■ Intra-asset:  if only one source asset exists and if destination record is having 
same asset but FA location is different then that will be changed.

■ Inter-asset:  If source asset and the destination assets are different then the 
program will perform cost and unit adjustment for both the assets.

■ If there is no destination asset then the program will create a new asset with the 
transaction quantity and appropriate cost. Then the cost & unit adjustments will 
be done for source asset. In case of serialized items the original asset cost will be 
updated to zero and you have to retire the asset manually.

In a situation where there exists more than one source record,  First In First Out 
method will be adapted. If more than one destination asset record exists then asset 
year will be matched to adjust the asset. When searching for the existing asset in the 
system, program will always look to see if there exists similar record under process. 
If it finds the exact match then the record will be skipped.

If your business rule dictates change in location as change in category then you 
have to modify client extension. In that case a new asset will be created for 
serialized item. The original asset cost will be updated to zero and you have to 
retire the asset manually. Similar unit and cost adjustments will be done in source 
and destination assets in the case of non-serialized items.

4.8 Physical Inventory and Cycle Count Adjustments
Depending upon the physical adjustment this transaction  will be treated same as  
Miscellaneous Issue or Miscellaneous Receipt. For example, if the item quantity 
increases after physical count then there will be Miscellaneous receipt transaction. 
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Case Study For the eIB-FA Concurrent Program
Run ’Post Mass Additions’ program from Oracle Assets to complete the asset 
creation

In the case of quantity reduction, this concurrent program will adjust the asset unit 
and cost. If the item is serialized then the asset will be retired.

4.9 Case Study For the eIB-FA Concurrent Program
The eIB-FA concurrent programs will process transactions in three group viz. 
Receipt of depreciable item, Normal item put in service and Asset item move 
transactions. The following is an example of transaction table and there scenarios 
that will be employed to handle them downstream.

User will run either Depreciable Item Assets or Normal Item flow.

(1) Lets assume depreciable item asset flow is run first. The concurrent program will 
pick up transactions 1, 6. Check if asset already exists for item I1 & I2 if it does then 
it will perform unit & cost adjustment. Otherwise it will create new asset.

(2) The next process flow is for Normal item. Here, it will pick transaction 5 only as 
transaction 3, 4 has no FA impact. After following all the process flows an asset will 
be created or cost adjustment eill be performed.

Table 4–5

Transaction Type Transaction ID Qty Details

Inter Organization move 2 25 Item I1 From A to 
Organization C

Receipt of Depreciable item 1 100 Item I1 in 
Organization A

Receipt of Normal item 3 150 Item I2 in 
Organization B

Equipment Installed 4 50 Item I2

Receipt of Depreciable item 6 25 Item I3 in 
Organization A

Equipment In Service 5 25 Item I1

Misc. Issue 8 5 Item I2 from 
Organization C to 
project P2
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Case Study For the eIB-FA Concurrent Program
(3) In the other transactions process, transactions 2 and 8 will be processed 
sequentially. If there is no asset related to item I1 in Organization C then transaction 
2 must be processed before transaction 8. These dependencies will be followed in 
the eIB-FA concurrent programs.

To insure the proper order of the transactions, the program will skip all the failed 
transaction record and their subsequent dependent transaction receords. For 
example, let’s say there are two transactions for the same asset, one of the first time 
receipt of the deprecciable  item into inventory and another for the sub-inventory 
change. If the first transaction is pending then the sub-inventory transfer will be 
skipped  and be processed when receipt transaction is over. However the program 
will not skip subsequent transaction which are independent of the prior. See the 
example below:

In the example 1, the transaction T2 is dependent on T1 and will not be processed. 
In the example 2, the transaction T5 is not dependent on T4 but on T3 which is 
complete, so transaction T5 can be processed.

4.9.0.1 Prerequisites
The following are setup Enterprise Installed Base Profile Options which need to be 
defined:

■ CSE: Debug log directory - This option is used to direct Enterprise Installed 
Base debugging messages to a specific file directory

■ CSE: Debug option - This option is used to turn on/off the Enterprise Installed 
Base debugging option

■ CSE: FA book type code - This option is used to set the default FA book type 
code for creation asset

Table 4–6

Tranaction Type Status

1 T1 New Asset Pending

T2 Asset Move ?

2 T3 New Asset Completed

T4 Asset added Pending

T5 Asset move ? qty move < qty available
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Understanding the CLEI
■ CSE: Issue to projects transaction - This option is used to Inventory User 
Defined transaction type for issuing item to project through the Inventory Move 
Order form

■ CSE: PA expenditure type - This option is used to set the default Project 
Accounting Expenditure type

■ CSE: Workflow notification recipient - This option is used to set the workflow 
notification recipient user id. Enterprise Installed Base will send notifications to 
this user ID

For more details see Installation Guide

4.10 Understanding the CLEI
The Common Language Equipment Identifier (CLEI) is a vendor-specific, 
10-character code. It is a standard used by the telecommunications industry for 
identifying and describing equipment. Because Oracle Enterprise Installed Base 
captures the CLEI code in the lot field, items that have a CLEI code must be set to 
full lot control. If an item has no CLEI code, it does not need lot control.

The supplier usually provides CLEI codes for the items you purchase. When 
performing transactions, you may select CLEI codes from a list of values, or you 
may enter new CLEI values directly into the Lot field.

See also:

 Defining Vendor Equipment Codes (CLEI). 

4.11 Overview of Retirements
The process that Enterprise Installed Base uses to retire and reinstate assets is the 
same as the process used in Oracle Assets, you may  retire or reinstate partial or 
whole assets.

Before you retire an asset, you must first take it out of service. If the asset being 
retired is in a depreciable subinventory, Enterprise Installed Base generates a 
miscellaneous issue transaction for the item and quantity. It then updates the item’s 
status to Retired. 

Asset must have a status of retired before they can be reinstated. An asset 
reinstatement reverses the operation of the Enterprise Installed Base retirement 
logic. For the reinstatement, Enterprise Installed Base generates a miscellaneous 
receipt transaction for the item and quantity and then updates the unit record status 
to "Out-of-Service".
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Using Enterprise Installed Base

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

5.1 Performing an Inquiry in Install Base
Use the following procedure to review item records in Oracle Install Base that are 
give details about Inventory, Assets and Projects.

Prerequisites

All inventory setups, such as organization and item creation, must be completed.

Steps

1. Click the My Products tab.

The Search My Products page  appears.

2. Click Personalized.

The Advanced Product search appears. 

3. In each basic category region, enter data in the fields

As necessary, use generic entries and the associated Go button to populate 
fields with specific values.

As necessary, click Clear to clear out your test entries.
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Understanding Installed Base Inquiry
4. In the Table Personalization region, use the Move and Remove commands and 
arrows to move selected columns between the list of available columns and 
columns that you select for displays

5. Use the arrows in the right-hand column of the personalization table to arrange 
the display sequence of your selected columns. The column titles as arranged 
from the top to bottom ara displayed from the left to right on the Search My 
Products page.

6. As appropriate , click one of the following:

■ Search:  Find values that satisfy the current search criteria.

■ Save As:  Saves the current search criteria with a name that you enter.

■ Save:  Saves the search criteria under the most recently used name for 
search criteria.

■ Save and Search:  Saves the search criteria under the most recently used 
name for search criteria and then performs a search that uses those criteria.

See also:

 Understanding the Item Summary Window

5.2 Understanding Installed Base Inquiry
The Oracle Installed Base support tracking of any unit regardless of business party 
relationships (i.e. owner), location, or accounting classification. Installed Base is a 
respository for tracking information about items. Asset can also be tracked by 
defining them as item instances in the Installed Base and establishing a link 
between those item instances and corresponding Assets in the Asset System. Use 
the Oracle Installed Base home page to see how items are distributed within the 
enterprise.

5.3 Viewing the Inventory Details
Use Oracle Install Base home page to view inventory information about a selected 
item, such as subinventory , lot number, revision, vendor serial number, and 
vendor name.

Prerequisites

None.
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Viewing the Assets
Steps

1. Click the My Product tab.

The Serach My Product appears.

2. Choose blank from LOV in Saved Searches and click Personalize.

The Advanced Product Search page appears.

3. Enter data in the Item Number field, use % for wildcard seach.

4. Click Search. The Search Results page appears

5.  Click on the Description field to view the details of inventory item

5.4 Viewing the Assets
Use Oracle Installed Base home page to view and define associated asset 
information such as asset number, date placed in service, and employee. Use this 
procedure to view an asset.

Prerequisites

None.

Steps

1. Click the My Product tab.

The Search My Product appears.

2. Choose blank from LOV in Saved Searches and click Personalize.

The Advanced Product Search page appears.

3. Enter data in the Item Number field, use % for wildcard search.

4. Click Search. The Search Results page appears

5.  Click on the Description field to view the details of item

6. In the side navigation menu, select Asset.

The Asset page appears, here you can view asset information.
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Submitting a Request
5.5 Submitting a Request
Use the Submit Request window to request one of the following reports and 
concurrent processes in Enterprise Installed Base:

■  Requesting an eIB Assumed Loss Rate Report

■  Requesting an eIB Bill of Lading Report

5.5.1 Viewing Request Results
When you request a report, Enterprise Installed Base assigns a number to your 
request, runs the request and stores the report. Use this procedure to view the 
report you requested.

Prerequisites

You must request a report and save the request ID number.

Steps

1. In the Enterprise Installed Base responsibility, navigate to Requests > View.

2. In the Find window, click Specific Request and enter the ID number of the 
report you wish to view. 

3. Click Find to retrieve the record.

4. Click View Output to see the report online.

If the report was completed with errors, choose View Log to see a list of the 
errors that were encountered when your request was processed. 

5. To print the report, in the Menu Bar choose Tools > Reprint. 

Enter the number of copies to print, the printer, and the print style. 

6. Click Save to complete the reprint request.

5.6 Requesting an eIB Assumed Loss Rate Report
Use this procedure to generate a list of items that have been issued to projects but 
have never been placed in service. 
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Requesting an eIB Assumed Loss Rate Report
Prerequisites

None.

Steps

1. In the Enterprise Installed Base responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose Enterprise Installed Base Assumed Loss Rate Report.

4. Choose either Detail or Summary Report Type. 

Detail displays all individual transactions that meet your criteria. Summary 
provides only transaction totals.

5. In the Parameters window, you may enter information in the fields to define 
your search. 

If you leave all optional fields blank, the search returns all records across all 
organizations in the format you requested. 

Project Number. To limit your search results to those items that have been 
issued to a specific project, enter the project number here.

Task Number. To further limit your search results to those items that have 
been issued to a particular task for a project.

Organization. To limit your results to a particular organization, enter that 
organization here.

Inventory Item. To limit your search results to records for a specific item, 
enter the item number here.

6. Click OK to close the Parameters window.

7. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also: 

Viewing Request Results
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Requesting an eIB Bill of Lading Report
5.7 Requesting an eIB Bill of Lading Report
The bill of lading displays: the move order number; transaction request date; the 
ship-to location name and address; the project number; task number; line item 
number; item number; item revision; quantity requested and quantity shipped, both 
with totals for each item number; CLEI; serial number; and vendor serial number. 
Follow these steps to generate a bill of lading.

Prerequisites

None.

Steps

1. In the Enterprise Installed Base responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. In the Name field, choose Bill of Lading Report.

4. In the Parameters window, you may enter information in the fields to define 
your search. 

If you leave all fields blank, the report will include all move orders for the 
current da��

Move Order Number. To limit the report to a specific move order, enter 
that number here.

Organization Name. To limit the report to a specific organization.

Date From. To limit the report to all move orders generated from a specific 
date forward, enter that date here.

Date To. To limit the report to all move orders generated before a specific 
date, enter that date here.

Project Number. To limit the report to only those move orders for a specific 
project, enter that project number here.

Task Number. To limit the report to only those move orders for a particular 
project task, enter that task number here.

Location. To limit the report to only those move orders for a particular 
physical location, enter that location here.
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5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

See also:

 Viewing Request Results

Guidelines

To print a bill of lading for a specific range of dates, enter a date in both Data 
Required From and Data Required To. If you do not enter any dates in these fields, 
the bill of lading report shows all move orders up to the system date.

If you enter a value for Task Number, enter a corresponding Project Number.

To keep the report results to a manageable length, enter data for as many of the 
parameter fields as possible.

5.8 Finding Personal Profile Values
In the Find Personal Profile Values window, you can search for the personal profile 
values that have already been defined in other Oracle modules. Then use the 
Personal Profile Values window to display and make changes to your personal 
settings. Do not enter user values unless you require a setting that is different from 
the default setting.

Follow these steps to find and edit personal profile values used in the Enterprise 
Installed Base module.

Prerequisites

Profiles 

Steps

1. In the Enterprise Installed Base responsibility, navigate to Setup > Profiles.

The Find Personal Profile Values window opens.
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2. Click [...} to open the list of values.

The Organizations window appears.

3. Enter CUN% in the Find field and click Find.

The Profiles window displays the profiles for Enterprise Installed Base.

4. Select the profile you want to edit and click OK.

The Find Personal Profile Values window displays the name of the selected 
profile.

5. Click Find.

The Personal Profile Values window opens and displays the selected profile.

6. Enter values in the User Value column to customize the user profile.

You cannot edit a gray field.

7. Select File > Save to save your changes. 
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Administering Enterprise Installed Base

This topic group provides task-based procedures that are required for ongoing 
system maintenance and includes information on administration tools and utilities.

6.1 Each Transaction Generates a Message
Every transaction of a trackable item generates a message to the application. When 
the application receives a message, it searches the Enterprise Installed Base tables 
for a record of the item. If it finds the record and all the attributes have been defined 
in the record, the transaction occurs without errors.

However, when a transaction results in an error, the related message is sent to the 
appropriate log. For example, if a Receipt-to-Project transaction of a normal item is 
missing attributes for category or location, a fatal error occurs. The message that is 
sent as a result of this transaction is sent to the Error Log. 

6.2 Transaction Status Complete (C)
The application changes the status of a transaction to Complete (C), when the 
following conditions are met: 

■ The transaction has not generated any errors

■ The transaction is complete

■ The transaction is not dependent on another incomplete transaction

See also:

■  Understanding the Enterprise Installed Base Recovery Process

■  Deleting a Record on the Redo Log
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6.3 Understanding the Message Dequeuer
A message dequeuer is a background process that continuously polls a queue and 
processes the items from the queue. The message dequeuer removes messages from 
the message queue on a first-in, first-out (FIFO) basis. Message queues are 
maintained by Oracle Advanced Queueing (OAQ). For information about message 
queues, see also:

■ The Oracle Provisioning System Queues

■ Administering the System Queues

■ Managing the System Queues

You can manage the message queues in either Oracle Provisioning or Oracle 
Number Portability. Enterprise Installed Base uses the messaging system that is 
maintained in Service Delivery Platform (SDP). For more information about the 
messaging system, see Using the iMessage Studio.

When you start a message queue, a controller process automatically starts the 
dequeuers. For more information about starting and suspending a message queue, 
see:

■ Oracle SDP Start 

■ Oracle SDP Stop
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